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I. Overview 

Embest UNetICE for ARM is the new-generation high-speed real time in-c

ircuit emulator that Embest introduced in August 2004 after the release of E

mbest PowerICE for ARM and Embest Emulator for ARM. 

Compared with Embest PowerICE for ARM and Embest Emulator for ARM,

 this new emulator has following added features:  

� Supports both 10/100M Ethernet and USB port communication,  

user can choose one of the two connection ways or shift between  

them; 

� Supports Embest IDE for ARM, ARM/SDT and ARM/ADS integrated d

evelopment environment; 

� Downloading and debugging speed up to 800KB/S; 

� Supports Internet sharing among development team and remote  

debugging; 

� With powerful emulator management software UNetICE Manager tos

upport the settings of online IP address, subnet address, Mac  

address; fast software upgrade within 30s; it has an information  

window to provide auxiliary debugging information; 

 

Main features: 

1. Supports ARM series kernel chips; 

2. Driver program supports Windows98/NT /2000 /XP; 

3. Supports standard 20-pin JTAG port; 
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4. Supports assembler level debugging, support ARM. THUMB and instruc

tion set across debugging; 

5. Supports standard C language program debugging; 

6. Non-plug-in debugging, consume no resources of board; 

7. Supports high-speed online Flash programming; 

8. Supports maximum two hardware breakpoints, two data breakpoints a

nd unlimited software breakpoints. 
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II. UNetICE Connections 

2.1 UNetICE Hardware 

Embest UNetICE emulator includes:  

- JTAG port for connecting target board; 

- USB and Ethernet ports for connecting host 

- RESET and UPDATER buttons 

- External power supply socket and power switch 

- Red, green, yellow emulator state indicator 

See details in diagram below:  

  

Figure 2-1 Frontal view of UNetICE 

 

Figure 2-2 Rear view of UNetICE 
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No. Item Functions 

1 Power indicator (PWR) Indicate the state of power supply 

2 State indicator (RUN) Indicate running state of emulator 

3 Alarm indicator (ALARM) Indicate error alarm 

4 
Ethernet port 

The communication port connected to host in 

Ethernet way. 

5 
USB port 

The communication port connected to host in USB 

way. 

6 External power supply 

socket 
Use external power supply 

7 
Power switch 

Switch power supply modes (USB power supply / 

external power supply) 

8 RESET Reset emulator 

9 JTAG port 20-pin IDC plug port 

10 
UPDATER (FUNC) 

Press the button when resetting the emulator to 

enter updater mode 

 

2.2 Connections of emulator 

In the host-target machine cross development model, through debugging 

device the host is connected with target machine, and conducts download and 

debugging. UNetICE is a JTAG emulator, connected to JTAG port of target board 

via a 20-pin IDC straight-through cable (1-1, 2-2, … 20-20), connected to host 

through USB or Ethernet port. User can select an appropriate connecting way 

according to their requirement. 

USB connection type 

USB (Universal Serial Bus) is a new port technology in PC application, it 

provides power supply and high-speed telecom channels for peripheral 

equipment, bringing users a lot of convenience. 
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The host can be connected to UNetICE emulator through a special USB cable. 

See figure below, the A-type male port in the left is connected with the A-type 

female port of host, the B-type male port in the right is connected with the B-type 

female port of target board. If you need to use USB as power supply device, you 

can adjust the power switch. 

 

Figure 2-3 USB cable 

Ethernet connection type 

There are two ways of Ethernet connection, one is standard Ethernet 

connection, use two parallel network cable (see figure below) to connect host, 

target board and HUB to constitute a LAN. The other way is using one cross cable 

to connect the host and target machine directly. 

 

Figure 2-4 Ethernet cable 

Power supply 

User can choose 5V power supply through USB port by operating power 

switch; or alternatively choose 6~9V external power supply. In external power 

supply socket, the inside is positive, the outside is negative, see the figure 

below: 

Embest Info&Tech Co.,LTD.  
Tel: +86 755 25635656 
Fax: +86-755-25616057 
Email: market@embedinfo.com  

Room 509, Luohu Science&Technology Building,  
#85 Taining Road,  
Shenzhen, Guangdong, China(518020) 
http://www.embedinfo.com 

 

7



 

 

Figure 2-5 power supply socket 

2.3 Indicators 

Functions of indicators: PWR: indicate the state of power supply; RUN: 

indicate running state of emulator; ALARM: indicate error alarm. See details in 

the table below: 

Names of 

indicators 
Description of indicator state  

PWR Power indicator “on”: indicate normal power supply. 

RUN 

When the emulator is powered on, it enters normal mode, the 

indicator is on. 

In normal mode, when the debugging software is connected 

to emulator, the indicator blinks; 

When the emulator is powered on, while in updater mode, the 

indicator is on (ALARM indicator is also on) 

In updater mode, during the process of downloading, the 

indicator blinks; 

ALARM 

The indicator is on, the system enters updater mode; 

The indicator turns on, then turns off in 1 second, indicating 

an alarm message created; 

The indicator blinks for 5 seconds, turns on then turns off in 1 

second, indicating an error message created. 

 

2.4 Port signal 

z JTAG 
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The definition of JTAG port is shown in the figure below (the RES pin can be 

used for future upgraded versions, please refer to relevant specification) 

 

Figure 2-6 Definition of 20-pin JTAG port cable 

Description of pin signal 

Signal I/O Description 

GND — Power Ground. 

TDI Output The testing data input signal from Embest Emulator 

to JTAG port of target board, It is recommended to 

add a pull-up or pull-down resistance.  

TMS Output The testing mode signal from Embest Emulator to 

JTAG port of target board, the signal should be pulled 

up in target board, to avoid possible negative impact 

caused by change in TCK pin before connecting. 

TCK Output The testing clock signal from Embest Emulator to 

JTAG port of target board, It is recommended to add 

a pull-up or pull-down resistance. 

TDO Input The testing data output signal from JTAG port of 

target board to Embest Emulator. 

nSRST Output The system reset signal from open collector of 

Embest Info&Tech Co.,LTD.  
Tel: +86 755 25635656 
Fax: +86-755-25616057 
Email: market@embedinfo.com  

Room 509, Luohu Science&Technology Building,  
#85 Taining Road,  
Shenzhen, Guangdong, China(518020) 
http://www.embedinfo.com 

 

9



 

Embest Emulator to target board. the signal should 

be pulled up in target board, to avoid possible 

unexpected reset before connecting. 

RES — Reserved. 

 

 

z USB 

The definition of USB port is shown in the figure below: 

 

Figure 2-7 definition of USB port 

Description of pin signal: 

Signal Specification 

VDss USB port can be used to supply power to peripheral 

equipment, voltage range of USB port: 4.4-5.25V 

D+ Communication channel 

D- Communication channel 

GND Grounding 

 

z ETH 

The definition of Ethernet port is shown in the figure below: 
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Figure 2-8 Definition of Ethernet port  

Description of pin signal: 

Signal Specification 

TX+ Tranceive Data+  

TX- Tranceive Data-  

RX+ Receive Data+  

RX- Receive Data-  

n/c Not connected 

 

2.5 USB driver installation 

If connecting UNetICE emulator in USB way, you need to install USB driver 

program following the procedures below, the USB driver program is saved in the 

folder UNetICE USB Driver under root directory of driver CD. 

1. Connect PC and UNetICE emulator through USB cable, when the emulator 

is powered on, PC finds the new USB device and pops up a dialog box “Found New 

Hardware Wizard” , click “NEXT”; 

2. Select “search for a suitable driver for my device” in the dialog box “Install 

hardware driver program”, click “NEXT”; 

3. Select “Specify a location” in the dialog box “Found driver program files”, 

click “next”, choose USB driver folder in the source of manufacturer file, e.g. 

F:\UNetICE USB Driver. 
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4. When the installation is completed, the system displays “Completing the 

Found New Hardware Wizard”, indicating you have successfully installed Embest 

UNetICE device. 
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III. Configuration of emulator 

Embest UNetICE Manager is the special management software of UNetICE 

emulator, it is used to Setup IP address, MAC address, subnet address of 

emulator, load and upgrade modules, output debugging information. 

To ensure normal connection, debugging and downloading, user need to use 

Embest UNetICE Manager to properly configure the emulator before using it. 

3.1 Embest UNetICE Manager 

z Introduction 

Embest UNetICE Manager is the software kit of Embest UNetICE emulator, it 

is used to setup IP address, MAC address of UNetICE, update and upgrade 

UNetICE firmware, in addition, when UNetICE supports SDT2.51/ADS1.2 

environment to conduct development and debugging, UNetICE Manager 

provides information window to display output information of UNetICE. 

Embest UNETICE has two working modes: normal and updater. The settings 

of IP address, MAC address and firmware update, upgrade proceed in updater 

mode, emulator monitoring information in normal debugging mode. 

z Installation 

Embest UNetICE Manager runs in PC, supporting Windows98 / Windows2000 

/ WindowsXp. To install it, run setup.exe under folder /UNetICE Manager, the 

default installation directory is {EmbestIDE}\Tools\UNetICE Manager, user can 

select an installation directory from the browse window, and can create a 

shortcut if necessary. Restart PC when the installation is finished. 
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Figure 3-1 Installation interface 

3.2 Setup IP address 

To Setup IP address, the emulator must work in Updater mode. The IP 

address can follow the steps below: 

(1) Start-up emulator and enter Updater mode 

Continuously press Updater button of Embest UNetICE emulator, press 

RESET button to restart UNetICE emulator, let the emulator enter Updater mode, 

UNetICE’s RUN and ALARM indicators are on after start-up, indicating Updater is 

ready to operate. 

(2) Run Embest UNetICE Manager 

Run Embest UNetICE Manager in PC, select the property page [Setup IP 

Address]. 
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Figure 3-2 UNetICE IP address setting interface 

(3) Configure options of telecom 

Select the option [Setting]→[Configure…], configuration dialog box pops up. 

In the column Remote Device, select UNetICE. 

In the column Debug Speed, select Full Speed.  

In the column Select Communication Type, select USB or TCPIP according to 

the communication type between UNetICE and the host, if you choose TCPIP�

enter UNetICE’s current IP address in IP Address column. 
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Figure 3-3 configure USB communication type 

 

Figure 3-4 Configure TCP/IP communication type 

Notice: if you don’t know UNetICE’s IP address, you can choose 

USB communication type to set it. 

 

(4) Get displayed IP address setting information 

Click [Refresh] button, if the communication type is properly set, UNetICE’s 

current IP address information will be displayed in the column Current IP. 
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Figure 3-5 The original IP address 

(5) Setup IP address 

In the column Setup IP, enter the IP address, Subnet Mask code to be setup. 

If you need setup UNetICE’s MAC address, enter 12-digit hexadecimal MAC 

address in the column MAC. 

 

Figure 3-6 Setup UNetICE IP address 

Notice: make sure the IP address, MAC address to be setup do not 

conflict with other machines, subnet mask code compliant to 

subnet. If you have modified UNetICE MAC, you need to restart the 

host directly connected with UNetICE. 

 

(6) Write setup parameters and return 

When you have confirmed IP address, click [Setup] address to setup 

UNetICE’s address. When the setup is finished, click [Refresh], the IP address 

already set will be displayed in the left column Current IP. 
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Figure 3-7  New IP address after setup 

(7) Restart UNETICE 

When IP address setup is finished, restart UNetICE, UNetICE will run the 

software at the new IP address (on condition that the new address does not 

conflict with other host IP addresses). 

3.3 Software upgrade 

Embest UNetICE Manager supports the online upgrade of the emulator. The 

upgrade files include master program files and debugging module files that 

support various processors. The function and version of files can be displayed in 

UNetICE Manager interface, users can download the latest version of files from 

Embest’s website. The software can be upgraded following the procedures 

below: 

(1) Start-up emulator and enter Updater mode. 

Continuously press the Updater button of Embest UNetICE emulator, press 

RESET button to restart UNetICE emulator, let the emulator enter Updater mode,  

UNetICE’s RUN and ALARM indicators are on after start-up, indicating Updater is 

ready to operate. 

(2) Run Embest UNetICE Manager 

Run Embest UNetICE Manager in PC, select the property page [Download 

Image]. 
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Figure 3-8 UNetICE software upgrade interface 

(3) Configure options of telecom 

Select the option [Setting]→[Configure...], Configuration dialog box pops up. 

In the column Remote Device, select UNetICE. 

In the column Debug Speed, select Full Speed.  

In the column Select Communication Type, select USB or TCPIP according to 

the communication type between UNetICE and the host, if you choose TCPIP�

enter UNetICE’s current IP address in IP Address column. 
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Figure 3-9 Configure USB communication type 

 

Figure 3-10 Configure TCP/IP communication type 

Notice: if you don’t know UNetICE’s IP address, you can choose 

USB communication type to set it. 

 

   (4) Load upgrade files 

Enter the path of upgrade files in the column Image path, then click the 

button [Load File], UNetICE Manager will automatically identify the upgrade file 

modules, if the file is legal UNetICE software upgrade files, the software interface 

will automatically display the information of upgrade files. 
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Figure 3-11 UNetICE Manager displays the information of upgraded files 

(5) Download upgrade files to UNETICE 

Click [Download] to download the files to UNetICE, UNetICE will 

automatically update corresponding software modules, in upgrading process, 

RUN indicator blinks. When check is completed, UNetICE software upgrade is 

finished. 

 

Figure 3-12 the interface after UNetICE software upgrade 

 (6) Reset UNetICE 

When the software upgrade is finished, reset UNetICE, UNetICE will run 

based on the upgraded software. 
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3.4 Emulator monitoring information 

UNetICE emulator supports the debugging under ARM SDT 2.51 and ARM 

ADS 1.2 development environment. If UNetICE is used under SDT or ADS 

environment, UNetICE Manager will provide an information window to monitor 

output information of UNetICE. 

(1) Start-up Embest UNetICE Manager configure communication 

options 

Run Embest UNetICE Manager in PC 

Select [Setting]→[Configure...], Configuration dialog box pops up.  

In the column Remote Device, select UNetICE.  

In the column Debug Speed, select Full Speed.  

In the column Select Communication Type, select USB or TCPIP according to 

the communication type between UNetICE and the host, if you choose TCPIP, 

enter UNetICE’s current IP address in IP Address column. 

 

Figure 3-13 configure USB communication type 
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Figure 3-14 Configure TCP/IP communication type 

Notice: if you don’t know UNetICE’s IP address, you can choose 

USB communication type to set it. 

 

(2) Open UNetICE information output channels 

Select the menu [File]→[Message Window], an information window pops up, 

when information output monitoring window is opened, UNetICE information 

output window will be automatically opened.  

 

Figure 3-15 Open monitoring information window  
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If you have opened several UNetICE windows, the most recent UNetICE 

information window is current window. The effective information window will 

prompt “Open remote output ok!”; if the opened information window fails to 

connect UNetICE, it will prompt “Cann’t open remote output.” 

 

Figure 3-16 UNetICE information window open ok 

 

Figure 3-17 UNetICE information window connect failed 

(3) Close UNetICE information output 

Close information output window, UNetICE information output channel will 

be closed. 

(4) Clear message 

Move the mouse to information output window, click the right button of 

mouse to pop up the menu, select [Clear Message] to clean the old message. 
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Figure 3-18 Clear the old message  

(5) Reconnect UNetICE 

When the information opens, it automatically connect UNetICE, if connection 

fails, or UNetICE resets, reconnect UNetICE. Move the mouse to output window, 

click the right button of mouse to pop up the menu, select [Open Remote], 

reconnect UNetICE. 

 

Figure 3-19 Reconnect UNetICE 
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IV. Software settings 

4.1  Embest IDE settings 

Run Embest IDE, select the option Project>Settings…, pop up the dialog box 

“project settings”, select Remote option, see the figure below, user can configure 

the connection of emulator. 

 

Figure 4-1  Ethernet connection configuration of UNetICE emulator 

There are two setting items in the dialog box: 

Remote device: it is to set the remote debugging device, if you use UNetICE, 

choose “UNetICE”, see the above figure. 

Speed: it is to set the download debugging speed, this setting is only 

available when the emulator supports debugging download speed. 

Embest UNetICE Full Speed, High Speed, Medium Speed, Low Speed. 

Communication type: set the way of connection between the emulator and 

host. 

Embest UNetICE TCPIP  Ethernet connection 

USB  connection 

IP Address: set IP address of UNetICE emulator, this address can be set 

online through UNetICE Manager software.  
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If you select USB communication type, no IP address setting page will be 

displayed. 

 

Figure 4-2 USB connection configuration of UNetICE emulator  

References of error information 

UNetICE emulator has added the following error information, other error 
information please refer to Embest IDE User’s Manual 
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1001 Usb or net initial failed. 

 Brief description Usb or net initial failed. 

 Reasons and 
solution 

Possible reasons:  

� UNetICE emulator is not started-up, 
restart it. 

� USB or network cable is improperly 
connected, check USB or network 
cable connection. 

� USB is blocked, use IDE to reconnect 
UNetICE, or reset the emulator to 
reconnect UNetICE. 

� USB driver load failed; disconnect 
IDE, reset the emulator then 
reconnect. 

� IP or MAC address conflict with other 
hosts; use UNetICE Manager to 



 

reconfigure the emulator’s IP or 
MAC address. 

� IP address of UNetICE in IDE is 
incorrect, set correct IP address of 
emulator in IDE. 

1002 send command failed. 

 Brief description send command failed 

 Reasons and 
solution 

Possible reasons:  

 Send data failed in the communication 
with UNetICE emulator, disconnect IDE 
and UNetICE emulator, reconnect 
them. 

1003 receive response command time out. 

 Brief description receive response command time 
out .  

 Reasons and 
solution 

Possible reasons:  

 Receive response command time out in 
the communication with UNetICE 
emulator, disconnect IDE and UNetICE 
emulator, reconnect them. 
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	I. Overview

	Embest UNetICE for ARM is the new-generation high-speed real time in-circuit emulator that Embest introduced in August 2004 after the release of Embest PowerICE for ARM and Embest Emulator for ARM.
	Compared with Embest PowerICE for ARM and Embest Emulator for ARM, this new emulator has following added features:
	Supports both 10/100M Ethernet and USB port communication, �user can choose one of the two connection ways or shift between �them;
	Supports Embest IDE for ARM, ARM/SDT and ARM/ADS integrated development environment;
	Downloading and debugging speed up to 800KB/S;
	Supports Internet sharing among development team and remote �debugging;
	With powerful emulator management software UNetICE Manager tosupport the settings of online IP address, subnet address, Mac �address; fast software upgrade within 30s; it has an information �window to provide auxiliary debugging information;
	�
	Main features:
	1. Supports ARM series kernel chips;
	2. Driver program supports Windows98/NT /2000 /XP;
	3. Supports standard 20-pin JTAG port;
	4. Supports assembler level debugging, support ARM. THUMB and instruction set across debugging;
	5. Supports standard C language program debugging;
	6. Non-plug-in debugging, consume no resources of board;
	7. Supports high-speed online Flash programming;
	8. Supports maximum two hardware breakpoints, two data breakpoints and unlimited software breakpoints.
	II. UNetICE Connections
	2.1 UNetICE Hardware


	Embest UNetICE emulator includes:
	JTAG port for connecting target board;
	USB and Ethernet ports for connecting host
	RESET and UPDATER buttons
	External power supply socket and power switch
	Red, green, yellow emulator state indicator
	See details in diagram below:
	�
	Figure 2-1 Frontal view of UNetICE
	�
	Figure 2-2 Rear view of UNetICE
	No.
	Item
	Functions
	1
	Power indicator (PWR)
	Indicate the state of power supply
	2
	State indicator (RUN)
	Indicate running state of emulator
	3
	Alarm indicator (ALARM)
	Indicate error alarm
	4
	Ethernet port
	The communication port connected to host in Ethernet way.
	5
	USB port
	The communication port connected to host in USB way.
	6
	External power supply socket
	Use external power supply
	7
	Power switch
	Switch power supply modes (USB power supply / external power supply)
	8
	RESET
	Reset emulator
	9
	JTAG port
	20-pin IDC plug port
	10
	UPDATER (FUNC)
	Press the button when resetting the emulator to enter updater mode
	
	2.2 Connections of emulator


	In the host-target machine cross development model, through debugging device the host is connected with target machine, and conducts download and debugging. UNetICE is a JTAG emulator, connected to JTAG port of target board via a 20-pin IDC straight-thro
	USB connection type
	USB (Universal Serial Bus) is a new port technology in PC application, it provides power supply and high-speed telecom channels for peripheral equipment, bringing users a lot of convenience.
	The host can be connected to UNetICE emulator through a special USB cable. See figure below, the A-type male port in the left is connected with the A-type female port of host, the B-type male port in the right is connected with the B-type female port of
	�
	Figure 2-3 USB cable
	Ethernet connection type
	There are two ways of Ethernet connection, one is standard Ethernet connection, use two parallel network cable (see figure below) to connect host, target board and HUB to constitute a LAN. The other way is using one cross cable to connect the host and 
	�
	Figure 2-4 Ethernet cable
	Power supply
	User can choose 5V power supply through USB port by operating power switch; or alternatively choose 6~9V external power supply. In external power supply socket, the inside is positive, the outside is negative, see the figure below:
	�
	Figure 2-5 power supply socket
	
	2.3 Indicators


	Functions of indicators: PWR: indicate the state of power supply; RUN: indicate running state of emulator; ALARM: indicate error alarm. See details in the table below:
	Names of indicators
	Description of indicator state
	PWR
	Power indicator “on”: indicate normal power suppl
	RUN
	When the emulator is powered on, it enters normal mode, the indicator is on.
	In normal mode, when the debugging software is connected to emulator, the indicator blinks;
	When the emulator is powered on, while in updater mode, the indicator is on (ALARM indicator is also on)
	In updater mode, during the process of downloading, the indicator blinks;
	ALARM
	The indicator is on, the system enters updater mode;
	The indicator turns on, then turns off in 1 second, indicating an alarm message created;
	The indicator blinks for 5 seconds, turns on then turns off in 1 second, indicating an error message created.
	
	2.4 Port signal


	JTAG
	The definition of JTAG port is shown in the figure below (the RES pin can be used for future upgraded versions, please refer to relevant specification)
	�
	Figure 2-6 Definition of 20-pin JTAG port cable
	Description of pin signal
	Signal
	I/O
	Description
	GND
	—
	Power Ground.
	TDI
	Output
	The testing data input signal from Embest Emulator to JTAG port of target board, It is recommended to add a pull-up or pull-down resistance.
	TMS
	Output
	The testing mode signal from Embest Emulator to JTAG port of target board, the signal should be pulled up in target board, to avoid possible negative impact caused by change in TCK pin before connecting.
	TCK
	Output
	The testing clock signal from Embest Emulator to JTAG port of target board, It is recommended to add a pull-up or pull-down resistance.
	TDO
	Input
	The testing data output signal from JTAG port of target board to Embest Emulator.
	nSRST
	Output
	The system reset signal from open collector of Embest Emulator to target board. the signal should be pulled up in target board, to avoid possible unexpected reset before connecting.
	RES
	—
	Reserved.
	USB
	The definition of USB port is shown in the figure below:
	�
	Figure 2-7 definition of USB port
	Description of pin signal:
	Signal
	Specification
	VDss
	USB port can be used to supply power to peripheral equipment, voltage range of USB port: 4.4-5.25V
	D+
	Communication channel
	D-
	Communication channel
	GND
	Grounding
	ETH
	The definition of Ethernet port is shown in the figure below:
	�
	Figure 2-8 Definition of Ethernet port
	Description of pin signal:
	Signal
	Specification
	TX+
	Tranceive Data+
	TX-
	Tranceive Data-
	RX+
	Receive Data+
	RX-
	Receive Data-
	n/c
	Not connected
	
	2.5 USB driver installation


	If connecting UNetICE emulator in USB way, you need to install USB driver program following the procedures below, the USB driver program is saved in the folder UNetICE USB Driver under root directory of driver CD.
	1. Connect PC and UNetICE emulator through USB ca
	2. Select “search for a suitable driver for my de
	3. Select “Specify a location” in the dialog box �
	4. When the installation is completed, the system
	III. Configuration of emulator

	Embest UNetICE Manager is the special management software of UNetICE emulator, it is used to Setup IP address, MAC address, subnet address of emulator, load and upgrade modules, output debugging information.
	To ensure normal connection, debugging and downloading, user need to use Embest UNetICE Manager to properly configure the emulator before using it.
	
	3.1 Embest UNetICE Manager


	Introduction
	Embest UNetICE Manager is the software kit of Embest UNetICE emulator, it is used to setup IP address, MAC address of UNetICE, update and upgrade UNetICE firmware, in addition, when UNetICE supports SDT2.51/ADS1.2 environment to conduct development and d
	Embest UNETICE has two working modes: normal and updater. The settings of IP address, MAC address and firmware update, upgrade proceed in updater mode, emulator monitoring information in normal debugging mode.
	Installation
	Embest UNetICE Manager runs in PC, supporting Windows98 / Windows2000 / WindowsXp. To install it, run setup.exe under folder /UNetICE Manager, the default installation directory is {EmbestIDE}\Tools\UNetICE Manager, user can select an installation dire
	�
	Figure 3-1 Installation interface
	
	3.2 Setup IP address


	To Setup IP address, the emulator must work in Updater mode. The IP address can follow the steps below:
	(1) Start-up emulator and enter Updater mode
	Continuously press Updater button of Embest UNetI
	(2) Run Embest UNetICE Manager
	Run Embest UNetICE Manager in PC, select the property page [Setup IP Address].
	�
	Figure 3-2 UNetICE IP address setting interface
	(3) Configure options of telecom
	Select the option [Setting]?[Configure…], configu�
	In the column Remote Device, select UNetICE.
	In the column Debug Speed, select Full Speed.
	In the column Select Communication Type, select U
	�
	Figure 3-3 configure USB communication type
	�
	Figure 3-4 Configure TCP/IP communication type
	Notice: if you don’t know UNetICE’s IP address, y
	(4) Get displayed IP address setting information
	Click [Refresh] button, if the communication type
	�
	Figure 3-5 The original IP address
	(5) Setup IP address
	In the column Setup IP, enter the IP address, Sub
	�
	Figure 3-6 Setup UNetICE IP address
	Notice: make sure the IP address, MAC address to be setup do not conflict with other machines, subnet mask code compliant to subnet. If you have modified UNetICE MAC, you need to restart the host directly connected with UNetICE.
	(6) Write setup parameters and return
	When you have confirmed IP address, click [Setup]
	�
	Figure 3-7  New IP address after setup
	(7) Restart UNETICE
	When IP address setup is finished, restart UNetICE, UNetICE will run the software at the new IP address (on condition that the new address does not conflict with other host IP addresses).
	
	3.3 Software upgrade


	Embest UNetICE Manager supports the online upgrade of the emulator. The upgrade files include master program files and debugging module files that support various processors. The function and version of files can be displayed in UNetICE Manager interface
	(1) Start-up emulator and enter Updater mode.
	Continuously press the Updater button of Embest U
	(2) Run Embest UNetICE Manager
	Run Embest UNetICE Manager in PC, select the property page [Download Image].
	�
	Figure 3-8 UNetICE software upgrade interface
	(3) Configure options of telecom
	Select the option [Setting]?[Configure...], Configuration dialog box pops up.
	In the column Remote Device, select UNetICE.
	In the column Debug Speed, select Full Speed.
	In the column Select Communication Type, select U
	�
	Figure 3-9 Configure USB communication type
	�
	Figure 3-10 Configure TCP/IP communication type
	Notice: if you don’t know UNetICE’s IP address, y
	(4) Load upgrade files
	Enter the path of upgrade files in the column Image path, then click the button [Load File], UNetICE Manager will automatically identify the upgrade file modules, if the file is legal UNetICE software upgrade files, the software interface will automatica
	�
	Figure 3-11 UNetICE Manager displays the information of upgraded files
	(5) Download upgrade files to UNETICE
	Click [Download] to download the files to UNetICE, UNetICE will automatically update corresponding software modules, in upgrading process, RUN indicator blinks. When check is completed, UNetICE software upgrade is finished.
	�
	Figure 3-12 the interface after UNetICE software upgrade
	(6) Reset UNetICE
	When the software upgrade is finished, reset UNetICE, UNetICE will run based on the upgraded software.
	
	3.4 Emulator monitoring information


	UNetICE emulator supports the debugging under ARM SDT 2.51 and ARM ADS 1.2 development environment. If UNetICE is used under SDT or ADS environment, UNetICE Manager will provide an information window to monitor output information of UNetICE.
	(1) Start-up Embest UNetICE Manager configure communication options
	Run Embest UNetICE Manager in PC
	Select [Setting]?[Configure...], Configuration dialog box pops up.
	In the column Remote Device, select UNetICE.
	In the column Debug Speed, select Full Speed.
	In the column Select Communication Type, select U
	�
	Figure 3-13 configure USB communication type
	�
	Figure 3-14 Configure TCP/IP communication type
	Notice: if you don’t know UNetICE’s IP address, y
	(2) Open UNetICE information output channels
	Select the menu [File]?[Message Window], an information window pops up, when information output monitoring window is opened, UNetICE information output window will be automatically opened.
	�
	Figure 3-15 Open monitoring information window
	If you have opened several UNetICE windows, the m
	�
	Figure 3-16 UNetICE information window open ok
	�
	Figure 3-17 UNetICE information window connect failed
	(3) Close UNetICE information output
	Close information output window, UNetICE information output channel will be closed.
	(4) Clear message
	Move the mouse to information output window, click the right button of mouse to pop up the menu, select [Clear Message] to clean the old message.
	�
	Figure 3-18 Clear the old message
	(5) Reconnect UNetICE
	When the information opens, it automatically connect UNetICE, if connection fails, or UNetICE resets, reconnect UNetICE. Move the mouse to output window, click the right button of mouse to pop up the menu, select [Open Remote], reconnect UNetICE.
	�
	Figure 3-19 Reconnect UNetICE
	IV. Software settings
	4.1  Embest IDE settings


	Run Embest IDE, select the option Project>Setting
	�
	Figure 4-1  Ethernet connection configuration of UNetICE emulator
	There are two setting items in the dialog box:
	Remote device: it is to set the remote debugging 
	Speed: it is to set the download debugging speed, this setting is only available when the emulator supports debugging download speed.
	Embest UNetICE
	Full Speed, High Speed, Medium Speed, Low Speed.
	Communication type: set the way of connection between the emulator and host.
	Embest UNetICE
	TCPIP  Ethernet connection
	USB  connection
	IP Address: set IP address of UNetICE emulator, this address can be set online through UNetICE Manager software.
	If you select USB communication type, no IP address setting page will be displayed.
	�
	Figure 4-2 USB connection configuration of UNetICE emulator
	References of error information

	UNetICE emulator has added the following error in
	1001
	Usb or net initial failed.
	Brief description
	Usb or net initial failed.
	Reasons and solution
	Possible reasons:
	UNetICE emulator is not started-up, restart it.
	USB or network cable is improperly connected, check USB or network cable connection.
	USB is blocked, use IDE to reconnect UNetICE, or reset the emulator to reconnect UNetICE.
	USB driver load failed; disconnect IDE, reset the emulator then reconnect.
	IP or MAC address conflict with other hosts; use 
	IP address of UNetICE in IDE is incorrect, set correct IP address of emulator in IDE.
	1002
	send command failed.
	Brief description
	send command failed
	Reasons and solution
	Possible reasons:
	( Send data failed in the communication with UNetICE emulator, disconnect IDE and UNetICE emulator, reconnect them.
	1003
	receive response command time out.
	Brief description
	receive response command time out .
	Reasons and solution
	Possible reasons:
	( Receive response command time out in the communication with UNetICE emulator, disconnect IDE and UNetICE emulator, reconnect them.

